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Co je LabWindows/CVI

Vyvojove prostredie zalozené na jazyku ANSI C
vytvorené National Instruments

Jednoduchy a rychly vyvoj aplikacii pre
spracovanie signalov, meranie, generovanie,
archivaciu a komunikacie

Kompatibilné s Visual C a Borland C
Vlastny alebo externy kompilator

Kniznice funkcii pre rézne aplikacie — zrychlenie
a zjednodusenie programovania



Zakladné viastnosti a moznosti

Prehladné prostredie - pracovny priestor
(workspace) s jednoduchym ovladanim

Automaticke generovanie typickych kostier
programovych struktur (main, for, while, ...) a
deklaracii a inych sucasti programov

Interaktivny vykon kniznicnych funkcii

Rychla orientacia v knizniciach a vyhladavanie
funkcii

Kontextovy pomocnik (help) v kazdom kroku
programovania



Pracovne okno (workspace window)

 Nastavenie cez Option»...

i SProgram FilessM ational | nstrumentshCV1 B0 sampleshanalpsisihonlnfit. cws

\National Instruments\CVIB0\sample: alysisinoninfit. cws
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¢ nonlnfit.c the fitting function

=3 Include Files
] noninfith

= User Interface File:
En i %

% Main Function

s% The main function loads and displaw E nonlnfit. uin

int main (int argc, char *argv[])
Nonlinear Fit Example
if (InitCVIRTE (0. argv. 0) == 0}

return -1 <% out of memory)  Pgins

if ({mainpnl = LoadPansl {0, "nonl g'IZE
return -1;
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=% File/Director
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AddT oFil
GetFilzP:
25| ClearFilef
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return 0;

GetCtrlVal
GetCtrlVal
coef=[0] =
coef=s[1] =

(mainpnl,
(mainpnl,
idealparl:
idealpar?;

seed++
if (=eed » 50) {
zeed = 1:

for (1=0:
#wave[i] = 1i:
if {functtemplate
if {(functtemplate
datawave[1]

}

DeleteGraphPlot (mainpnl.

Gaus=sNoi=ze (numpoints,

i <num1:n:|1nt8;

wold FitCurveProcedure{woid)

MAINPNL IDEALPARL,
MATINPNL_IDEALFPARZ,

MAINFNL_G

nois=elevel,
i++) 4

== () datawaw
== 1) datawawv|

= datawave[i] + noi

&idealparl):
&idealparl);

E nonlnfit. uir

[ Al

onlinear Fit Example

=1> nonlnfit.c £ : :

Paitts
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Data Template

g Damped Sinusoid

Wariance from [deal

* lot¥ (mainpnl,

1f (functfit == 0) {

el=ze {

T 5w m e TS

HonLlinearFit (zwawve,
1, é&meansgerror):
SetInputdode (mainpnl.
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[ata Template Function

* Fit Function

IY[X] = Expl-a"] " Cozlws]

|deal Parameter a
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* Fit Parameter a Mean Squared Ermor

¥ &t Fit Curve
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Kniznicneé okno (library tree)

=243 |Li|:uraries|

-l User Interface Library
ﬂ Advanced Analysiz Library
ﬂ Formatting and /0 Librany
ﬂ [tility Library
-4 ANSIC
-l Traditional NI-DAQ Library
- MI-DADms Library
-l ¥ Library
-4l GPIB/GPIB 488.2 Library
j' R5-232 Library
-l Y154 Library
-4l W Library
ﬂ TCP Suppart Library
- DataSocket Library
ﬂ DDE Suppart Library
G-gl Activer Library

~{7 Instruments

=

Prehlad vyber — vyber — info o polohe funkcie

Prisposobenie aktualneho suboru kniznic cez
_ibrary»Customize, zobrazenie cez View»...

a1 Customize Library Menu

Mational Instruments Libranes
W dnalysis

W Traditional MI-DAQ

W MNI-DA

W MI-CAM

v il

W GFIB/GFIE 4882

Idser Libraries

C N ational [nstumentsyCyiB0 Binnivision. in n
C:\Program FilessM ational InztrumentshCWIS08binkzpt. Ifp —
C:A. AW ational [nstrumentsSCyYIB04binsniimagds. fp
C:A A ational [nstrument 2 CWIB00binYnimag 1394 fp —

LA AMational Instrument S CWYIB0MBinhimagio. fp
C:A AMational Instrument S CI804binkniimag. fp =

A ALYIBDh boolslibhdatasock\datazkt. fp il

C:A . AMational [nstrumentzSCVIB0Mbinkodt Ifp

C:A. AMational [nstrument S CyI804binsnimasconfig. fp
C:\Program FilessM ational Inztrumentzh Sy 804bintzmt. fp
C:A L ACYIBON toolslibtoolboxtoolbow. fp

Eazte Above

J Pazte Below

[Changez do not take effect until the nest session. ]




Standardné kniZnice

User Interface Library—Functions for creating and controlling a graphical user interface.

Analysis Library (Base Package)/Advanced Analysis Library (Full Development
System)—Functions that operate on arrays to simulate and analyze large sets of numerical
data quickly and efficiently.

Formatting and 1/O Library—Functions for inputting and outputting data to files and
manipulating the format of data in a program.

Utility Library—Functions that perform various operations, including using the system
timer, managing disk files, launching another executable, and using multiple threads in a
program.

ANSI C Library—The ANSI C standard library functions.

VXI Library, GPIB/GPIB 488.2 Library and RS-232 Library —Functions for
communicating with and controlling VXI devices, General Purpose Interface Bus (GPIB)
and RS-232 ports using interrupt-driven 1/O.

VISA Library —Functions for controlling VXI, GPIB, serial, and other types of instruments.

TCP Support Library —Functions that provide a platform-independent interface to the
reliable, connection-oriented, byte-stream, network communication protocol.

Internet Library —Functions that communicate with and receive files and commands from
remote servers.

DDE Support Library —Functions that you can use to create an interface with other
Windows applications using the DDE standard.

ActiveX Library —Functions that create and control ActiveX servers.

DIAdem Connectivity Library —Functions that you can use to log test data in National
Instruments DIAdem file format (.tdm).

NET Library —Functions that facilitate calling .NET assembilies.



Okno projektu (project window)

Projekt = zoznam vsetkych zdrojovych (.c),
deklaracnych (.h), grafickych (.uir), a dalSich
suborov (.obj, .lib, .fp, ...) , ktoré spolu vytvaraju
aplikaciu

Vytvorenie noveho/nacitanie existujuceho cez
menu File

Nastavenie zobrazenia_ cez View»Columns
alebo iné polozky vo View

V pracovnom priestore moze byt sucasne
otvorenych viacero projektov — aktivny je
zvyrazneny (dvojklik)



Zdrojove okno (source window)

« Vytvorenie nového/nacitanie existujuceho cez menu File
« Editacia
— Vkladanie pripravenych skeletonov: Edit » Insert Construct

— Vkladanie funkcii

- priame pisanie s inteligentnym doplifianim (prvé pismena»pravé
tlaCidlo»Recall Function Panel
* Vyber z kniznice (knizni¢né okno alebo ponuka Library»...)

— Deklaracie premennych: priamy zapis alebo poloautomatizované
cez Function Panel vybranej funkcie

* Ladenie
— Vkladanie preruseni (breakpoint) — klik do favého stipca

— RO&zne urovne krokovania Runy... alebo ikony na liSte

— Sledovanie hodnét premennych (watch) — menu pod pravym
tlaCidlom mysi



Panel funkcie (Function Panel)

« K dispozicii ku kazdej funkcie z kniznic cez menu pod
pravym tlacidlom mysi

& Untitled.cws FEX
1 File Edit %ew Code Buld Run  Instrument  Lbrary Tools  Window  Options  Help
* Vyplnenle parametrov T EES e S eS|

. EEX

User Interface Library - File Select Popup

do policok —
praVé tIaéIdIO:heIp Deefault Drectory: IlliJefaulltlFileSpec " fnewpeust _ Tille
* Deklaracia premennej, | -
vlozZenie existujucej = - <
premennej cez Code O ]| s -
alebo ikony na liste we [ —]

eeeeee /P

FileSelectFopup (""., ".=", """ "" VAT TOAD BUTTON, 0, 0, 1, 0, ); 4

!




Pomocnik k polozke, funkcili, ...

1 Control Help IS[=]

Cottrol Hame: YWector X

Data Type: const double []

First vector used in the computation of the dot product,

¥l Function Help

Function Mame: DotProduct

Calculates the vector dot product of the input vectors, Dot Product obtains the dot
product using the following formula:

n-1
dotProd = x ey = Z?gix ¥
i=1a
Prototype ;I

AnalysisLibErrType DotProduct (const double Vector X[],

const double Vector T[], int Nuwber of Elements,

double *Dot_Product)




Deklaracia premennej (s ctri-n),

ol Declare Yariable

Wariable Type: int

Y ariable Marme: nunpoint=s

v Execute declaration in Interactive ‘Window

[ &dd declaration to top of target file "nonlnft

[+ i&dd declaration to current block in target file “nonlnft.c'

| Set Target File... I | k. | | Cancel | | Help I

Interaktivny vykon instrukcie

Interactive Execution !IEI E

File Edit Wiew Build Run  Insktrument  Library  Tools  Window  Qpbions  Help

hEEIEEHEERERENEE ekt

finclude <an=i_c . h»r

finclude <utility ke

Cl=():

printf{"Welcone to the LabWindows-CWI Basics I Course."):

L oW D [0

15 | 35|ds | |IndEE EN A




GUI a editor grafickeho rozhrania

* Vytvorenie nového/nacitanie existujuceho cez menu File

« Dizajn: vytvorenie panelu a vlozenie grafiky z
KnizniCnych gra-

2F c:\...\Wational Instruments}CVIB0\samplesianalysisinoninfit.cws

fiCky’Ch prVkOV File Edit YWiew Create Arrange Code Build Run  Instrument  Library  Tools Window Options  Help

CEERI G %]

: o ioh [T
N aStaver]’Ie ICh [ Z InodnlaniIt.c M—
vlastnosti a norinith

=1 User Interface File:

= i 1.00-
vézby na -
. [ata Template Egg
ZdrOJ -C Cez ﬂDampedSinusoid omo-+—+—t++—+++—+—+ -+ttt
L] Yariance from ldeal 0.25
ich panely J=
. s Fit Data To 0

+ -4 Font Popup:
GetSyﬂemF‘J

dvojklik S s '
+ * Graph Popu ﬂ Darmped Sinuzoid 0 20 40 =] a0 a0 120127

SetSystemP : - : i
ElapEem Data Template Function - Fit Function - o Fit Curve .

KeyPress Even=

Callback Funct 0 ‘il = Expl-a™<] * Cos(w') © TR = Expl-a™<] ¥ Coslw™] ° | Eit Curve
zer Interface b

<
<
: Printing : Ideal Parameter a * Fit Parameter a Mean Squared Error : "
*
<

Mause and Cur - ﬁ 0,000 - 0.02000 0.00000

Riectangles anc Ideal Parameter w . Fit Parameter w

Bitmaps ’
@ Cipboard . %0z0000 020000

+
+
+
+
+
+
+
+

+ 4 Time Relate

dF
ol b Hﬂuman.:lﬂ
- =




Nastavenie vliastnosti panelu

2l Untitled. cws

File Edit Wew Create Arrange Code Build Run Instrument  Library  Tools  Window

CEX

Options  Help

HHE S|
l

i p
BTy

+ -4 Graph Popu

+ -4 Font Popup:
GetSystemP
SetSystemPJ

@ KeyPress Evensd

@ Calback Functi

@ User Interface t

@ Printing

@ Mouse and Cur

@ Rectangles anc

@ Bitmaps

@ Clipboard

@ Time Related F

<

Miscellaneous ¥
- | "

4
4
4
4
4
4
4
4
4
4

Untitled1.uir (=13

Untitled Panel

Dvojk

ol Edit Panel

Source Code Connection

PANE

Callback Function: |

Panel Settings
kP‘aneI Title:
-

kenu Bar:

Untitled Panel
ﬁ Mo Men Bar

Cloze Caontral:

Top ﬂ 24
Left 4
Height: = Fi5

Wwfidth:

Scroll Bars:

[ Auto-Center Wertically [when loaded)

[ Auto-Center Horizontally [when loaded)

Other Attributes. ..

Quick Edit Window

Untitled Panel =

Attributes for Child Panelz
Frame Style: ﬁ Bevelled
Frame Thickness: ﬂ 3

Title Bar Shyle: ﬂ Windows Style

Tile Bag Thickness: 4[21
¥ Size Title Bar Height to Font

| Title Style, . |

| Cancel l




Kniznice grafickych prvkov

2l Untitled.cws
File Edit ‘iew | Create | Arrange Code Build Bun  Instrument  Library  Tools Window  Options  Help

Eenel EEEE
Menu Bar. ..

Murmeric k ,
Iex Tl e
Command Bukkon K 0— 0—
Toggle Button Fowo- fin —
i - e
LED B ooa-— e T
Binary Switch 3 -10.0—'. “t0.0— 0w R
Ring 3 s : ot 5
. " [ S I
E Lists & Tables P a a:\ -10\&’
— Drecar ation booie -Eali-c @
[+ i G Graph , Wertical Level Slide
o F Fickure 3 ’ ’ ' :
g Timer ] . . . .
H [ = ]
e (3
o KeyF Caljgas _ _ _ .
‘ Calb Splitker 3
‘Q Ul ser Tah 4 B
i+ Printi Auctivel
‘ Mow: Classic-Style Controls 3
* i Custom Control ]
+ 4 Bitm: ustom Controls
'+ 4 Clipboard
[+ 4 Time Related F
i+ 4 Miscelaneous
i+ 4 L'/ DOS Comp
[+- 4 Monitors




Nastavenie vlastnosti prvkov




Vazba GUI na .c

Kazdy prvok moze byt indikatorom alebo ovladacim prvkom.

Meno prvku (premenna) = vznika naviazanim mien panelu a
prvku

Indikator (napr. graf, LED, ...) — odosielanie dat/ zistenie-
nastavenie vlastnosti podla mena prvku cez vhodné
kniznicné funkcie z User interface library.

Ovladac (Control, napr. tlacCidlo, potenciometer, menu, ...)
— zistenie stavu Citanim cez funkcie z User interface library
— Zistenie/nastavenie vlastnosti cez funkcie z User interface library

— Automatickeé spustenie (vyvolanie) obsluznej rutiny
(podprogramu) = program riadeny udalostami: zvolenej v okne
vlastnosti prvku — tzv. Callback (kostra automaticky
vygenerovana prostredim cez Code»Generate»...



Niektorée UIR funkcie

Panels
Load Panel LoadPanel
Load Panel (Extended) LoadPanelEx
Display Panel DisplayPanel
Pop-up Panels»Message/Prompt Popups
Message Popup MessagePopup
Controls/Graphs/Strip Charts»General Functions
Set Control Value SetCtrival
Get Control Value GetCtrival

Set Control Attribute SetCtrilAttribute
Get Control Attribute GetCtrilAttribute

User Interface Management
Run User Interface RunUseriInterface
Quit User Interface QuitUserlinterface

Controls/Graphs/Strip Charts»Graphs and Strip Charts»
Graph Plotting and Deleting
Plot Y PlotY
Delete Graph Plot DeleteGraphPlot

Controls/Graphs/Strip Charts»Graphs and Strip Charts»
Strip Chart Traces
Plot Strip Chart PlotStripChart
Clear Strip Chart ClearStripChart



Kostra programu pre GUI

P e e e
D a0 00 = T O e G0 P O D 00 ] O O e G [

Hinclude <uzerint ke
Hinclude “"genwave k"

ztatic int panelHandle;

int main ()

{

1t (panelHandle < 0} 1
Mesz=zagePopup( """, "Error Loading Panel");
return —-1;

F
el=ze
DizplayPanel (panselHandle):
: A% program code
feturn 0
21-21 C1c] | |Ins(EE 4] |

panelHandle = LoadPanel (0, "genwawe. uir", PANEL);




Nacitanie hodnoty

YWiew  Format

Bun “Window Ophons

o Yanables _ O] x|

Fil=  Edit

Help

el e =
panelHandle |1 int
nunber 12345 . 6700000000 [double i
1 ¥ buffer Q09A0950 "World"|char [100] ;I||
2 L |
3
4 |=tat _I‘ _I _.'I _I_I‘ LY LI _I_I‘ ﬁ
g statTo oo nunoe
B =tatic char buffer[100];
7
2 int main ()
E B
10 panelHandle = LoadFanel (0, "getwvalye. uir", PANEL):
3 Get Con... [M[=] E3 11 if (penelHandle < 0) {
1z MHessagePopup("". "Error Loading Ranel"):
13 return —1:
: 14 s
Strng [nput 15 else
1i6 Di=zplayPanel (panelHandle):
[w/orld e U - _
Te —p GC=tCtrlV¥al{panelHandle, PANEL STREIN, |buffer):
___________________________________ 19 > GCetCtrlVali{panelHandle., PANEL HUMIN. | &nunber)|
Mumernic |nput: )2?/ 3 SR U
22 =l
22,22 | 1d | |Ins|EE ] ol




Nastavenie hodnoty

"z=twalus . uir". PANEL):

"Error Loading Panel");

PANEL _STROUT. buffer);
PANEL_NUMOUT. number):

1 finclude {userint hr
2 finclude "setwalus h"
3
4 |=tatic int panelHandle;
5 =tatic double number:
B |=tatic char buffer[100];
7
g int main [)
9
10 panslHandle = LoadPanel (0,
11 i1f (panelHandle < 03 {
12 MesszagePopup(""
13 return —1;
ti Set Cont... =] E3 I LA

1lg Di=playPanel {panelHandle):
17
143 =trcpy (buffer, "Hello"):
19 number = 1.23;

Hello |< o SetCtrlVal{panelHandle,
21 gtCtrlV¥al{panelHandle,

”g%’,f”’feturn a:
Murnenc Output T 24 ;
123 | 24020 | 1c | |Ins/EE

4l |




Nastavenie vlastnosti prvku

[E3 Set Control Attribute [B[=] B3

WO 0D =] O O] e O P

2022

finclude <userint hr
finclude "SetAttributes h"

=tatic int panelHandle:

int main ()

CHAMGE M"r’.-’-‘-.TTHIELITES'

panelHandle = LoadPansel (0. "Set
if (panelHandle < 0) {
MezszagePopup("". "Error Logfing Panel"):
return -1

tributes . uir". PAHEL):

i

el=ze
DisplayPanel (panslHandle):

ATTER_CMD_BUTTON_COLOR. VAT BIUE):

[E3 Set Control Attribute [B[=] B3

‘f

SetCtrlAttribute (panelHandle, PANEL COMMANDBEUTTON. ’/////

SetCtrlAttribute (panelHandle, PAHEL COMMANDBEUTTON.
ATTR_TOF, 20):
return 0

| 1d | |Ins/EE Al Jsz

3 Set Control Attribute =] E3

A~




Riadenie udalostami

]EJdanst’ (event) na ovladacom prvku spésobi volanie prislusnej Callback
unkcie

Systém riadenia programu udalostami sa aktivuje funkciou
RunUseriInterface

Udalosti sa ukladaju do fronty
Pocas vykonu Callbacku ostatné udalosti (Callback funkcie) Cakaju.

Ak je potrebné v tomto Case umoznit vyvolanie iného callbacku, pouzite
ProcessSystemEvents, ak je potrebné vykonat vykreslenie
ProcessDrawkEvents

Ukoncenie riadenia programu udalostami sa vykona pomocou
QuitUserinterftace

stopFlag = 0;

1 Ad

1 |int =s=topFlag = 1; -
: -
J |void FunlU=zerInterface [ )
4
5 while (=topFlag)
b ProcessSystenEvent=() ;
A
a
9 |wvoid QuitlU=zerInterface { )
10 i
11
1z

1313 1 | |InsEE ] | iy




Ladenie

« Krokovanie

ﬂ——" c:h...\ Mational Instruments C¥IT0% samples’ analysis' convolyve.cws - [convolve.c]
File Edit Mew Build Bun  Instrumenk Window  Options

Library Tools Help

WES @h’llaﬂf%ﬁ. = @K}Fﬁljﬂ—‘lﬂ

El@ Convolve * Al 178 _1|
E}a Source Files 1719
" [domoeg] || 120
181
E}a Inciude FI|ES 143
convalve.h 147
E}-a U zer Interface | 144
LR corvolve.uin 185 switch (siglwavetype) o
186 caze 0:
187+ cinePattern (=igl
13283 breal:;
1219 caze 1:
_Iﬂ 1490 SquareWave (=iglpoint=s, 7.0, (=iglcyvcles<siglpoint=s). é&=iglpha=m
Mo =1 o191 500, wawvel):
=41 Libraries | 192 break:
j' IJzer Interface | LEe S 2o
: 194 TriangleWave (=iglpoint=. 7.0, (=iglcycles-siglpoints). &=iglph
[']j' Advanced Ana 1495 wawvell:
S Signal Gene 196 breal:;
. Impulze 137 ¥
-E] Pulz= LA
1919 if (=iglnoi=e == 1) {
. | Famp 200 GaussNoi=e (=iglpoints. =siglnoiseanp. seed. noisewavel);
Triangle 201 for (i=0; i<ziglpoint=s; i++) 1
---|S|neF"attn 202 wavel[1] = wavel[i] + noisewawvel[i]:
~&l| Uniform %Ef =l
[ BT TIE ==
| | =y 18?f698 13| | | | |Ins/B® Suspended |+ | D




Podmieneny breakpoint

« Nastavte jednoduché prerusenie (klik — stipec
vlavo v Source window

« Zvolte Run» Breakpoints

vl Breakpoints

Add/Edit [tem Delet po. Count ﬁ 0
GotoLine [ Dele  Condition: | W
<, Dizabled: r

| BEeplace ' | Add ' | Cancel ' | Help '




Sledovanie hodno6t premennych

« Z menu Windowy»Variables

o Variables

File Edit Wiew Format Run indow  Cptions  Help

(i = -
ffmbhal=s foowmod e ey
Sl e o SEIEICE oo
mainpnl 1 int
ziglwavetvpes 0 int
ziglpoint= 256 int
=iglphase 0.000000000000000E+0 double
¥ wavel O0=004112F0 double [2048]
¥ wavelResal O0=004152F0 double [2048]
¥ wavellmaginary 0=004192F0 double [2048]
=iglnolize 1 int
ziglcycles double
fianans fsirranfs (oo e _J
szcalefactor 1.000000000000000 double
of feetvalue 1.200000000000000E+1 double
i 1750290659 int
showlDeconviWarning ] int
AIIn foonnad e JhT s
T i Ine
¥ &Ergrr L L R ofEy *
Al T O T v

« Typ: presun kurzor nad premennu v *.c — zobrazi sa jej
hodnota



Komunikacia s hardvérom

* Princip: volanie sluzieb z ovladacov
integrovanych v OS (driver — obycajne .dll)
priamo alebo cez vysokourovnove funkcie v
statickych knizniciach (.lib). Drivery od vyrobcu
hardveru

* Multifunkéné karty od NI — driver v NI DAQmX
(starSie traditional NI DAQ)

« Specialne funkcie jednotlivé rozhrania (RS,
GPIB, ...) 1

* VISA - kniznica zovseobecnenych komunikacii
po fubovolnom rozhrani’

'pozri prislusné prednasky



Komunikacia s multifun. DAQ

* Nainstalovana a skonfigurovana karta (aj
virtualna) — Measurement and
automatization explorer — priradene
oznacenie napr. ,Dev1”

* Samotny program:
— ,manualne” zostavenie programu z funkcii v
kniznici DAQmMX
— Tools»Create/Edit DAQmMX Task
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Snimanie jednej hodnoty (vzorky)

Create Tasks and Channels
(DAQmxCreateAlVoltageChan)

Read a Single Sample
(DAQmxReadAnalogScalarF64)

Yes

Another Reading?

No

Clear
(DAQmxClearTask)




Viacbodové/hodnotové snimanie

Create Channels (DAQmxCreateAlVoltageChan)

Set Timing (DAQmxCfgSampCIlKTiming)

Start (DAQmxStartTask)

Read Samples (DAQmxReadAnalogF64)

Yes
Read More Samples?

No
Stop (DAQmxStopTask)

Clear (DAQmxClearTask)




Kontinualne analogove snimanie

Create Channels (DAQmxCreateAlVoltageChan)

1

Set Timing (DAQmxCFgSampCIlKkTiming)

A 4

Start (DAQmxStartTask)

v

> Read Samples (DAQmxReadAnalogF64)

Yes Y
Read More Samples?

No
Stop (DAQmxStopTask)

|

Clear (DAQmxClearTask)




Jednoduchy analogovy vystup

Create Tasks and Channels
(DAQmxCreateAOVoltageChan)

Write a Single Sample
(DAQmxWri1teAnalogScalarF64)

l

Yes

Write Another Sample?

Clear
(DAQmxClearTask)




Viachodnotovy analogovy vystup

Create Tasks and Channels
(DAQmxCreateAOVoltageChan)

Set Timing
(DAQmxCFgSampCIkTiming)
v

Write Data
(DAQmxWr1teAnalogF64)
v

Start
(DAQmxStartTask)
]

Wait until Done for Finite Samples
(DAQmxWartunti ITaskDone)
v

Stop
(DAQmxStopTask)
v

Clear
(DAQmxClearTask)




Kontinualny viacbodovy analogovy
vystup

Create Tasks and Channels
(DAQmxCreateAOVoltageChan)

Set Timing
(DAQmxCFgSampCIkTiming)

Write Data
(DAQmxWr1teAnalogF64)

Yes

Write More Samples?

No

Stop
(DAQmxStopTask)

Clear
(DAQmxClearTask)




Digitalny vstup

Create Channels
(DAQmxCreateDIChan)

v .
Multiple _ _ Single
Reading Single or

Specify Timing Multiple Samples?
(DAQmxCFgSampCIKTiming)

A 4 A\ 4

Start Read Sample
(DAQmxStartTask) (DAQmxDigitalScalaru32)

v

Read Samples ves ¥

(DAQmxReadDigitalu32)

A

Another Reading?

v Yes

More Samples? No
v NO

Stop
(DAQmxStopTask)

\ 4

Clear
(DAQmxClearTask)




Digitalny vystup

Multiple

Create Channels

Specify Timing
(DAQmxCFgSampCIkTiming)
A 4

Write Samples

(DAQmxWriteDigitalus)

Start
(DAQmxStartTask)

-

(DAQmxCreateDOChan)
v .
_ _ Single
Generating Single or
Multiple Samples?
Write Sample

Write More

<

A\ 4

Samples
)

All Samples Written?

] Yes

Wait Until Done

(DAQmxWaitunti ITaskDone)
A 4

Stop
(DAQmxStopTask)

No

(DAQmxWriteDigitalUus)

A 4

Clear
(DAQmxClearTask)




Komunikacia po Internete

« Zakladné funkcie na urovni protokolov
TCP/IP v kniznici TCP:

— Klient, server, podporne a doplnkove funkcie

 Vysokourovnoveé funkcie v kniznici Internet:
— ftp, telnet, email, web



Princip komunikacie

* Server aj klient musia mat svoju IP adresu

e Server po spusteni (registracii) Caka na pripojenie klienta

* Po pripojeni je komunikacia velmi jednoducha ako
Citanie a zapis dat do suboru = server dostava

poziadavky od klienta, ktoré vykonava a vysledky posiela
Klientovi

Klient 12s.161.15.29 Server 155.247.207.70

Inicializuje a riadi TCP.IP ”| Poskytuje data a
konverzaciu < i sluzby klientovi




Zakladné komunikacné funkcie

Server RegisterTCPServer
Client ConnectToTCPServer
>
v
| | |
ServerTCPWrite ServerTCPRead UnregisterTCPServer

CIientTCPWrite_

l

_CIientTCPRead__

1

DisconnectFromTCPServer

* Vyhodna instalacia Callback funkcie pre server
int TCPcallback (int handle, Int XType,

int errCode, void *callbackData);

xType = udalost, napr. pripojenie/odpojenie klienta, boli
prijaté data od klienta, ...




Co dalej?

* Nastudovat Getting start ...

* Nastudovat priklady v adresari Examples
a na web stranke www.ni.com

* Tvorit jednoduche programy



